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About This Book

Purpose

This guide describes how to use the exteNd Connect, referred to as the JDBC Component Editor. The
JDBC Component Editor is a standard component editor in Integration Manager.

Audience

This book is for developers and systems integrators who are planning to use Integration Manager to
develop database-aware services and components.

Prerequisites

This book assumes prior familiarity with Integration Manager’s work environment and deployment
options. Some familiarity with Structured Query Language (SQL) is also assumed.

Additional documentation

For the complete set of Novell exteNd exteNd Director documentation, see the Novell Documentation
Web Site (http://www.novell.com/documentation-index/index.jsp).

About the Product Name Change

In version 6.0. we've changed the name of exteNd Composer to Novell Integration Manager. In some
places in the user interface, and in Integration Manager file and directory names, you will still see the
name "exteNd Composer" or "Composer".


http://www.novell.com/documentation-index/index.jsp
http://www.novell.com/documentation-index/index.jsp
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Welcome to Integration Manager and JDBC

Before You Begin

Welcome to the Novell Integration Manager JDBC Connect User s Guide. This Guide is a companion to
the Novell Integration Manager User s Guide, which details how to use all the features of Integration
Manager except for the Connect Component Editors. So, if you haven’t looked at the Novell Integration
Manager User s Guide yet, please familiarize yourself with it before using this Guide.

Integration Manager provides separate Component Editors for each Connect, such as the JDBC
connector. The special features of each component editor are described in separate Guides like this one.

If you have been using Integration Manager, and are familiar with the core component editor (the XML
Map Component Editor), then this Guide should get you started with the JDBC Component Editor.

NOTE: To be successful with this Component Editor, you must be familiar with writing and constructing
SQL statements.

About exteNd Connects

Novell exteNd is built upon a simple hub and spoke architecture. The hub is a robust XML
transformation engine that accepts XML documents, processes the documents, and returns an XML
document. The spokes or Connects are plug-in modules that “XML enable” sources of data that are not
XML-aware. These data sources can be anything from legacy COBOL / VSAM managed information to
Message Queues to HTML pages. exteNd Connects can be categorized by the integration strategy each
one employs to XML enable an information source. The integration strategies are a reflection of the
major divisions used in modern systems designs for Internet based computing architectures. Depending
on your B2Bi needs, exteNd can integrate your business systems at the User Interface, Program Logic,
and/or Data levels.

What is JDBC?

JDBC is a Java-based API (Application Programming Interface) for executing SQL statements. While
often mistaken as an acronym meaning “Java Database Connectivity,” JDBC is in fact not an acronym at
all, but a trademarked name. JDBC consists of a set of classes and interfaces written in the Java
programming language that allows you to write one program to access different databases such as Oracle,
Sybase, Informix, etc., rather than needing to write a separate program for each one.

You can write a single program using the JDBC API and the program is able to send SQL statements to
the appropriate database. And since the application is written in the Java programming language, there is
no need to write different applications to run on different platforms. The combination of Java and JDBC
lets you write it once and run it anywhere, as the following illustration shows.

Welcome to Integration Manager and JDBC 9
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What Does JDBC Do?

JDBC makes it possible to do the following:

+ Establish a connection with a database

+ Send SQL statements (or queries) to be processed by the database

« Process the results of the database processing

JDBC is a low-level interface used to call SQL commands directly. It is integrated into Integration
Manager to interface between components and databases, allowing the program to establish connections

with the databases, send the SQL statements, and process the results. Integration Manager provides tools
that enable visual construction of the necessary SQL commands.

About exteNd’s JDBC Component

10

Much like the XML Map Component, the JDBC Component is designed to map, transform, and transfer
data between two different XML templates (i.e., request and response XML documents). However, it is
specialized to make a connection to a database, process SQL statements against the database using
elements from a Message Part within the query, and then map the results of the query to a Part.

A JDBC Component can perform simple data manipulations, such as mapping and transferring data from
one XML document to another, or from an XML document to a database table. It can also perform
sophisticated manipulations, such as requesting data from disparate databases, transforming data from
and to one or more documents, executing SQL transactions against the database, and even transforming
the documents themselves. Like an XML Map Component, the JDBC Component can process XSL, send
mail, and post and receive XML documents using the HTTP protocol.

JDBC Connect User’s Guide
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XML, XSL, DTD =P Processed
Composer

The JDBC Connect uses Integration Manager as the backplane for XML-based data interactions, making
it possible to reach into databases at runtime (and design time). Using Integration Manager, you can
assemble Action Models within a JDBC Component to carry out sophisticated data transformations,
using HTTP (optionally) as a transport mechanism. Live database connections are available at design
time, so that you can edit and debug SQL queries as part of the design process.

What Kinds of Applications Can You Build Using the JDBC
Component Editor?

You can build any business-to-business application that needs to push data into or pull data from a JDBC-
accessible data store and uses XML as the interchange format. For example, you can write an application
that retrieves the description, picture and price of a product from a database and displays it in the user’s
browser. If the information resides in two or more databases, you can merge the information from
separate databases before displaying it to the user.

Welcome to Integration Manager and JDBC 11
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Getting Started with the JDBC Component
Editor

Creating a JDBC Connection Resource

Before you create a JDBC Component, you will find it necessary to create a Connection Resource to
access the SQL database. Each Connect, including the JDBC connector, uses its own Connection type.
Each Connection type is differentiated by the number and types of parameters used to connect to the
specific external data source.

About Constant and Expression Driven Connection Parameters

You can specify Connection parameter values in one of two ways: as Constants or as Expressions. A
constant based parameter uses the value you type in the Connection dialog every time the Connection is
used. An expression based parameter allows you to set the value using a programmatic expression, which
can result in a different value each time the connection is used at runtime. This allows the Connection’s
behavior to be flexible and vary based on runtime conditions each time it is used.

For instance, one very simple use of an expression driven parameter in a JDBC Connection would be to
define the User ID and Password as PROJECT Variables (e.g.
PROJECT.XPATH(“USERCONFIG/MyDeployUser”). This way when you deploy the project, you can
update the PROJECT Variables in the Deployment Wizard to values appropriate for the final deployment
environment. At the other extreme, you could have a custom script that queries a Java business object in
the Application Server to determine what User ID and Password to use.

> To switch a parameter from Constant driven to Expression driven:
1  Click the right mouse button in the parameter field you are interested in changing.
2 Sclect Expression from the context menu and the editor button will appear or become enabled.

3 Click on the button and then create an expression that evaluates to a valid parameter value at
runtime. (Strings should be wrapped in double-quotes.)

Getting Started with the JDBC Component Editor 13
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Header Info | Connection Infa ]

Connection Type |JDEC Caonnection |_|
JDBC Driver |um ssaw jdbe.mss.odbe AgOdacDriver [ Default
JDBC LRL debc sssw odbc KCTutorial
User ID I =
Password I
DB Params | paste
Deployed Pool Mame I Select Al

Mlow SQL Transactions [

Clear All

Constant

v Expression

About JDBC Drivers and Connection Pools
When you create a Connection Resource, you are asked to provide a Driver Name and Connection Pool.

The JDBC Driver sun.jdbc.odbc.JdbcOdbcDriver is part of the JRE (Java Runtime Environment,
which you can find under the Novell exteNd5 directory), and you can use this driver to establish your
connection. But you can also obtain other JDBC drivers. For instance, the Novell exteNd Application
Server has its own JDBC drivers. Also, you can visit the Web site of the vendor for the SQL database
you’re using and download their driver(s).

A connection pool is a set of database connections managed by the application server for the various
applications it manages. It provides more efficient use of database and connection resources for multiple
applications running in the same application server. This, in turn, can improve overall system
performance. You can obtain the Pool Name for your application server from your Server Administrator.

For deployments within the Novell exteNd Application Server, the pool name will be JDBC/DBName
where DBName is the name that was used when the connection pool was added to the server. For
example, if you were connecting to the Samples50 database provided with the application server, the pool
name would be JDBC/Samples50.

> To create a JDBC connection resource:

1 Select File>New> xObject and select the Resource tab. Click on Connection. The “Create a New
Connection Resource” Wizard appears.

Create a New Connection Resource 1'

A Connection resource is used to establish communications with an Connectar data source orwith a server
uging HTTP authentication. You need to create connections for each type of data source ot each HTTP server
you wish to communicate with. Enter a name and, optionally, a description for this Connection. The name
will appear in the Composer Detail Pane and in choice lists when you are prompted for ohjects in Composer.
The name may not cantain the characters: s ?" = = | Names are case insensitive.

MName:

hiyrewConnection|

Description:

FPurpose:
Input
Output
Remarks:

(next ][ cancel
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6

7

8
9

Type a Name for the connection object.
Optionally, type Description text.

Click Next.

Create a New Connection Resource x|
Enter a Driver name (e.g. com.sssw.jdbc.oracle8.Oriver) and a driver specific URL for the database (e.0.
jubcissswooracle:MyYDB). Enter a connection poaol provided by the application server after deployment. Use
the right mouse button to create a conditional expression for a connection parameter. Checking ‘Default’
makes this Connection the initial selection when creating a JDBC Component. Use the Test button to check
your connection. You may save connections that fail the test.

Connection Type |JDBC Cornection [~]
IDBC Driver | [ Defautt
JDBC URL |
User ID I
Password I
DB Params I
Deployed Pool Mame I
Allow 50L Transactions
Help @ [ Back ][ Finish ][ cancel |

Select JDBC Connection from the Connection Type pull down menu.

In the JDBC Driver field, enter the name of the JDBC driver you want to use. For example,
com.mysql.jdbc.Driver for the Novell exteNd driver. (For more information see “About JDBC
Drivers and Connection Pools” on page 14.)

NOTE: This parameter, and all subsequent parameters in this dialog, can be dynamically set using
Expressions. See “About Constant and Expression Driven Connection Parameters” on page 13.

In the JDBC URI field, enter the location of the database you want to reach. For example,
jdbc:mysql://localhost:63306/samples50 where jdbc:mysql: is required syntax by the driver and
samples50 is an ODBC Data Source Name defined on the specific computer where the component
will run. In this example the database is installed on the localhost at port 63306. For deployment,
you may maintain connections directly to the database, provided that the server allows for ODBC
connectivity. The more likely scenario is that you will want to take advantage of the power of the
application server in managing database access. In that case, you need to provide the connection
pool name as described below.

NOTE: The JDBC Driver and JDBC URI fields are both case sensitive.
Enter a valid User ID to sign on to the selected database.
Enter a valid Password for the selected database.

10 In the DB Params ficld, enter any database-specific parameters that might apply to your

connection. Note that parameters should be entered as name=value pairs. If more than one
name=value param is specified, separate the pairs using semicolons, e.g.,
paraml=true;param2=true;param3=false.

NOTE: If no database-specific parameters will be used, enter false in this field.

11 Enter a Pool Name if required. For more information, see “About JDBC Drivers and Connection

Pools” on page 14.

NOTE: Connection pooling is only operational in the deployment environment. Setting the name
here will not affect Integration Manager connections. Only the deployed project will be affected.

12 Check the Allow SQL Transactions checkbox if you intend to exercise direct control over

transactions (using SQL Begin, Commit, and Rollback verbs) in your component’s Action Model.

Getting Started with the JDBC Component Editor 15



NOTE: This checkbox is mainly for backwards compatiblity with pre 5.0 versions of Integration
Manager. If transactions are required, it is recommended that this checkbox remain unchecked.
Explicit SQL "BEGIN", "COMMIT", or "ROLLBACK" actions should be substituted with the
Integration Manager Transaction action. This action uses JTA to manage the transaction. The
Transaction action is available form the Integration Manager Action>Advanced Actions Menu.

Checking the Allow SQL Transactions box has a number of effects:

« It turns auto-commit off for the JDBC driver. (The state of the auto-commit flag is restored,
however, at the end of the transaction, before returning the connection back to the pool.)

+ Itcauses all SQL commit and rollback commands to be translated to the corresponding JDBC
connection calls.

« It causes Integration Manager Enterprise Server to check the final Execute SQL Action in the
component to see that the final action is a commit or a rollback. If the final action is not a
commit or rollback, Integration Manager Enterprise Server performs a rollback by default, so
that a dirty connection (that is, a connection with uncommitted changes) is not inadvertently
returned to the pool.

NOTE: For a further discussion of the Allow SQL Transactions checkbox, see the Transactions

chapter of the Integration Manager Enterprise Server User’s Guide.

13 Check the Default checkbox if you would like to use the current connection as the default
connection for any new JDBC Components you create in your project.

14 Click Test to see if your connection is successful. A “success” or “failure” message appears for
your connection. You can continue creating the resource, even if your connection fails.

NOTE: This does not test the connection pool (if defined).

15 Click Finish. The newly-created resource connection object appears in the Integration Manager
Connection Resource detail pane.

¥ exteNd Composer: ActionExamples o ] 4]
File Edit View Tools Window Help

O=/%00X Novell
Cil- O Resource El

Bl codeTahle

[ Mame

InvertorySystem

New Connection
Resource

hybd onnection .

| Eprosect

1 Ml @, Fina][ F% watch|| « Todo|
Ready
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Creating XML Templates for Your Component

In addition to a connection resource, a JDBC component also requires that you have already created
XML templates so that you have sample documents for designing your component. (See Chapter 5,
Creating XML Templates, in the Novell Integration Manager User s Guide for more information.)

Also, if your component design calls for any other xObject resources such as custom scripts or code table
maps, it is best to create these before creating the JDBC Component. For more information, see Creating
Custom Scripts in the Novell Integration Manager User s Guide.

Getting Started with the JDBC Component Editor 17
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Creating a JDBC Component

Before Creating a JDBC Component

As with all exteNd components, the first step in creating a JDBC component is to specify the XML
templates needed. (For more information, see Creating a New XML Template in the separate Novell
Integration Manager User’s Guide.) Once you’ve specified the XML templates, you can create a

component, using the template’s sample documents to represent the inputs and outputs processed by your
component.

Also, as part of the process of creating a JDBC component, you can select a JDBC connection or you can

create a new one. If you create the connection beforehand, then it is available to all new JDBC

components. (See “Creating a JDBC Connection Resource” on page 13.)

> To create a new JDBC component:

1

H

Select File>New>xObject. Select the Component tab and then JDBC.

NOTE: Alternatively, under Component in the Integration Manager Navigator pane, you can

highlight JDBC, click the right mouse button, then select New.
The “Create a New JDBC Component” Wizard appears.

Create a New JDBC Component

AJDBC componentis used to push XML data into relational databases or pull data from thermn into XML
documents. This wizard will guide you through the creation of a JDBC Component. Please enter a name
and, optionally, a description for the JOEC component. The name will appear in the Composer Detail Pane
and in chaice lists when you are prompted for abjects in Compaser. The name may not contain the
characters:t f: 7 "= = | Mames are case insensitive {l.e. MyObjecthame is the same as myabjecthame).

Hame:

My DECComponent

Description:

Furpose:
Input:
Cutput:
Remarks:

[ |[ Next ][ Cancel

Enter a Name for the new JDBC Component.
Optionally, type Description text.

Click Next. The XML Input/Output Property Info panel of the New JDBC Component Wizard

appears.

Creating a JDBC Component

19



Create a New JDBEC Component |

Specify one or more XML Templates to help design Input to this Component ar'Wehb Service and only ane to
design Output. The sample ¥ML Documents in each Template are design time aids to help vou build Action
Madels forthe component. The samples are not actually used at runtime after deployment to your application
server. The ldentifier is fixed and reprasents the name used ta refer ta the XML Document during companent
execution. Selecting System {ANY} allows you to use an emply template {i.e. accept any document as Input).

Input Message

Part | Template Category | Template Name

|
Input | 5ystem) [ 4y v

Output Message

Part | Template Category | Template Name

|
Output | 5ystem) [ 4y v

[ Back ][ Mext ][ Cancel]

6 Specify the Input and Output templates as follows.

+ Type in a name for the template under Part if you wish the name to appear in the DOM as
something other than “Input”.

+ Select a Template Category if it is different than the default category.
+ Select a Template Name from the list of XML templates in the selected Template Category.

+ To add additional input XML templates, click Add and choose a Template Category and
Template Name for each.

+ Toremove an input XML template, select an entry and click Delete.
7 Select an XML template for use as an Output DOM using the same steps outlined above.

NOTE: You can specify an input or output XML template that contains no structure by selecting
{System}{ANY?} as the Input or Output template. For more information, see “Creating an Output
DOM without Using a Template” in the User’s Guide.

8 Click Next. The Temp and Fault XML Template panel appears.

Create a New JDBC Component x|

Specify ane ar more Temp and Fault XML Ternplates to help design temporary parts and fault handling for
this Camponent orWeb Service. Use Temp documents for creating intermediate results or holding values
for reference. Specify XML Templates to serve as Fault documents {o be passed back to clients under error
canditions.

Temp Message

Part Template Category Template Name |

Delete

Fault Message

Part ‘ Template Category | Template Mame |
| SystemFautt | (System} |:\| {Faut} |:||
Celete
[ Back ][ Next ][ Cancel |

9 If desired, specify a template to be used as a scratchpad under the “Temp Message” pane of the
dialog window. This can be useful if you need a place to hold values that will only be used
temporarily during the execution of your component or are for reference only. Select a Template
Category if it is different than the default category. Then select a Template Name from the list of
XML templates in the selected Template Category.

10 Under the “Fault Message” pane, select an XML template to be used to pass back to clients when
an error condition occurs.

20 JDBC Connect User’s Guide



11 As above, to add additional input XML templates, click Add and choose a Template Category and
Template Name for each. Repeat as many times as desired. To remove an input XML template,
select an entry and click Delete.

12 Click Next. The Connection Info panel of the “Create a New JDBC Component” Wizard appears.

Create a New JDBC Component x|

Specify which Connection yau wish to use farthis Component or Service. To change any connection
parameters, you must change them in the Connection Resource ohject or create a new Connection
Resource ofthe same type with different parameters.

Cannection |\nverrt0ry8ystem |i|

JDBC Driver |

JDBC URL |

User ID I

Password I

DB Params I

Deployed Pool Mame I

Allow 5QL Transactions

[ Back ][ Finish ][ Cancel ]

13 Select a JDBC Connection from the pull down list. For more information on the JDBC
Connection, see “Creating a JDBC Connection Resource” on page 13.

14 Click Finish. The component is created and the JDBC Component Editor appears.

¥ exteNd Composer: TutorialEnd [IDBC: Inventorylookup] =] (4]
File Edit Wiew Component Action Animate Tools Window Help EHE -8 x
@8 00X 9 S Novell
[ mventoryLookup | MyspBCCampanent |
trrzzznzaiiiii
@ Input Data B % 7 sav statement |(Resutt Mapping [ Result Text |
[l > PRODUCTREQU Dtz OperatorsMeywards: o
S yming hitp: e, COMPOS BF.CO '§' AghccessRights 2 saL [~]
<> gKu LORE437 (= AgAgents [ SELECT
[F-AgContents [#-DELETE
[zl Aglnfo [+l UPDATE
[#}-AgResources [#-INSERT
(= InventorySystem [+ Math
1B Output Data = ProductSystem [*)-Relational L
(5 <> INVENTORYSTAT, 1) Logical [+
<>kl
<> CATEGORY SQL Statement: [[] Execute As Prepared
> OMHAND SELECT * FROM InventorySystem WHERE SKL
<> CosT “InputxXPath{PRODUCTREQUESTISKU™'
<> oAl 77
FEERE2OI
- Native Environment | rmumookup
3
i H : B LOG ™r'n™ + "Component starting..." + ™rn" TO Systern Output using Log Level 5
Pane is empty until v ’ 2 i e
L/8F=ecute SQL: SELECT * FROM ImventorySystem WHERE SKU =“Input.XPath{"PROI]
“ »
an “SQL Statement Z5 MAP $TempINVENTORYSTATUS/SKU TO $Output INVENTORYSTATUS/SKU
. . MAP $TempANVENTORYSTATUSICATEGORY Via Code Table Map InventoryDisplay' T
action is added 5
5 MAP $TempINVENTORYSTATUS/STATUS TO $Output INVENTORYSTATUSISTATUS
ﬁf’ LOG ™rn" + “End of Component.” + "rin" TO Systern Qutput using Log Level
<1 ] B
Ready

About the JDBC Component Editor Window

The JDBC Component Editor includes all the functionality of the XML Map Component Editor. It
contains mapping panes for Input and Output XML documents as well as an Action pane.

The difference, however, is that the JDBC Component Editor also includes a Native Environment pane
common to all Connects. It appears as a grey pane until you create an SQL Statement action, at which
time it is populated with the Query pane, which is specific to the JDBC connector.

Creating a JDBC Component 21



NOTE: To display the Query Pane, you must first select SQL Statement from the Action menu and
create an SQL action. Otherwise, the pane remains greyed out.

W exteNd Composer: TutorialEnd [IDBC: Inventorylookup] o ] 54|
File Edit View Component Action Animate Tools Window Help BHO -8 x
ODEE@E Y00 X 9 <€ Novell
|'%@ InventoryLookup ][‘E@ MyJDBCCompanent |
B Input Data 0 x
£ <> PRODUCTREQY
< ¥mins hittp-ifinanad COMpOS erco
Input Native Environment
mapping pane pane
@ Output Data Ox @ G=] Eﬁ gt | Q il
5 > INVENTORYSTAT
<>s5kuU 7 LOG "Inn" + “Companent starting...” + "rin" TO Systern
<> CATEGORY .
<> ONHAND SQL Execute SQL; SELECT * FROM InventorySystern WHERE
<>cosT = TO $OUtpULINVEN
<> cTaTl £ . GORY ‘ia Code T
Output = Action Model pane s ¢ soutputie
mapping pane W " TO Systerm OL
< ] ]
Peady
About the Query Pane

When the Query pane (i.e., the activated Native Environment pane) is showing—that is, when an SQL
Statement action is selected—it becomes a fully functional SQL environment for creating and testing
queries in real time. From this pane, you can perform the following:

+ Take data from an Input Message (or other available Message Part) and use it to create or modify an
SQL Query against a relational data source

+ Take the results of that query and put it into a Message Part (e.g., Temp, Output, MyDom, etc.)

The Query pane includes three tabs: the SQL Statement tab, the Results Mapping tab, and the Results
Text tab.

SQL Statement Tab

When the Query pane first opens, it displays the SQL Statement tab in a live SQL environment. The SQL
Statement tab is where you’ll write or build SQL commands. (See illustration below.) It may be necessary
to resize the SQL Statement pane in order to see the SQL edit box. You can build whole or partial
statements by doubleclicking nodes in the Data and/or SQL Operators trees, or by typing SQL straight
into the bottom of the window.

SQL Staterment | Result Mapping | Result Text'
Data: Operatorsikeywords:
-imventorySystem _+| | ®-80L -
. ---Math
~CATEGORY [#-Relational
-ONHAND [#-Logical
-COST El-Functions
STATLIS j Loape j
SOL Staternent: [ Execute As Prepared
SELECT * FROM InventorySystern WHERE SkU
="Input ¥Path"PRODUCTREQUEST/SKU"Y
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Result Mapping Tab

The Result Mapping tab allows you to map the result of your database query into an XML document. It
also allows you to designate the exact XML branch element under which you’d like the query result to
appear. The Result Mapping tab is shown below.

S0L Staternent Result Mapping | Result Textl

Result Row Placement
Enterthe XML element to place results under:

s =

[INVENTORYSTATUS g

ol |7 Create element names as column names
F Create elements if column is null
I_ Include datatype info in element attribute

|_ Generate Row numbers
0 Custam Column/RomyGraup

I- Stored Procedure mapping

e |
e

Result Text Tab

The Result Text tab (see below) displays the actual SQL statement sent and the data that was returned
following the execution of the database query. This is helpful if errant data shows up in a Temporary or
Output Part. You can compare the data from the Result Text tab with the data in the XML Message to see
where the error occurred.

|' SOL Statement || Result Mapping | Result Text ]

EXECUTED:
SELECT * FROM InventarySystem WHERE SKU ='LORS437"

Sk CATEGORY  OMHAND COST STATUS

LORE43T 1 0 275 Out of
Stacki{on re-arder)
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Performing JDBC Actions

About Actions

An action is similar to a programming statement in that it takes input in the form of parameters and
performs specific tasks. Please see the chapters in the Novell Integration Manager User s Guide devoted
to Actions.

Within the JDBC Component Editor, a set of instructions for processing XML documents or
communicating with non-XML data sources is created as part of an Action Model. The Action Model
performs all data mapping, data transformation, data transfer between SQL databases and XML
documents, and data transfer within components and services.

An Action Model is made up of a list of actions. All actions within an Action Model work together. As
an example, one Action Model might contain individual actions that read invoice data from a disk,
retrieve data from an inventory database, map the result to a temporary XML document, make a
conversion, and map the converted data to an output XML document.

The Action Model mentioned above would be composed of several discrete actions. These actions
would:

+ Open an invoice document and perform an SQL command to retrieve invoice data from a database
+ Map the result to a temporary XML document
+ Convert a numeric code using a Code Table and map the result to an Output XML document

Two of the actions available in Integration Manager are specific to JDBC Components. These are the
SQL Statement Action and the SQL Batch Action.

Mew Action L SOL Statement. .,
0L Batch. .,
Advanced 4 I
M=ot F nhm b

These actions are described below.

The SQL Statement Action

The SQL Statement action is most commonly used to query an existing database and then map the result
to an XML document. However, the full set of SQL Data Manipulation Language (DML) statements can
be utilized (including database inserts, deletes, and updates).

There are two ways to use the SQL Statement Action. The first is to create your SQL statement using the
wizard. The second is to create a custom SQL statement either by typing it in directly or by selecting
command statements from the ECMAScript Expression Builder. In either case, you should be familiar
with SQL database commands and with the structure of the database(s) you are querying in order to
create valid statements with the SQL Statement action.
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Handling of Binary Data

When you obtain binary data from a database that supports binary types (such as MySQL, which
supports CHAR BINARY, VARCHAR BINARY, TINYBLOB, BLOB, MEDIUMBLOB, and
LONGBLOB binaries), you are dealing with data that potentially contains characters and/or character
combinations that are illegal in XML.

NOTE: Merely mapping such data into a CDATA section is not a satisfactory solution, because some
characters (such as “angle brackets”) are illegal in CDATA. Also, the character-combo “]]>” is not allowed
within CDATA, since it signals the end of a CDATA section.

One satisfactory way to handle binary data is to use Base64 encoding, which essentially turns arbitrary
byte streams into XML-safe ASCII streams. Integration Manager’s default behavior is to automatically
Base64-encode binary data whenever possible, such as when binary data are returned from a database
during a SELECT or other “read” operation. Conversely, Integration Manager will automatically
Base64-decode binary data before INSERTing or otherwise pushing it into a database. You do not have
to take any special action to make this happen.

If you want to take direct control over encoding or decoding of data, you can do so with the Integration
Manager-defined ECMAScript extension methods base64Encode() and base64Decode(). The former
takes a byte[ | array argument and returns a String. The latter takes a String and returns a byte[ ] array.

Prepared Statements

The JDBC Connect has the ability to prepare (or precompile) SQL commands and cache them in memory
so that when the same command executes over and over again (for example, in a loop), the cached
statement can be reused, with new argument values inserted as need be. This can be a significant
performance optimization in cases where statements execute many times.

You can designate any SQL statement as a “prepared statement,” whether it was created manually or via
the wizard, by using the “Execute as prepared” checkbox. This checkbox is located on the first dialog of
the wizard, and also provided just above the SQL edit box for manually created SQL Statements:

|_ Exacute A= Prepared

By default, this checkbox is unchecked. For SQL Statement actions that are executed only once in the
course of a service’s lifetime, it is recommended that you leave the checkbox disabled. For statements
inside loops, the checkbox can be checked.

NOTE: You may want to do some benchmarking to determine whether and to what degree using the
Execute as Prepared checkbox is beneficial in a given application.

Creating an SQL Statement using the Wizard

The SQL Creation wizard leads you through the process of creating an SQL query. Integration Manager
offers you the ability to create SQL statements using the SELECT, DELETE, INSERT and UPDATE
commands. Of course, the userid with which you access the database must have the privileges required
to perform these actions for your JDBC component to work correctly. Most userids will be able to
SELECT from tables by default, but often you must have special permission to perform DELETE,
INSERT and UPDATE actions on tables. Check with your Database Administrator if you are in doubt.

The SQL SELECT Statement

26

The SQL Select Statement is used to select and return data from a table. For examples on how to use the
SQL Select statement, refer to http://www.w3schools.com/sql/sql_select.asp. Depending on the size and
structure of your table, a simple SELECT statement may return a lot of data. For this reason, SELECT
statements are often filtered using a WHERE clause.
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> To create an SQL SELECT Statement action using the wizard:
1 Create or open a JDBC Component.

2 Highlight a line in the Action Model where you want to place the SQL Statement action. The new
action will be inserted below the line you highlight.

3 From the Action menu, select New Action, then SQL Statement.

4 Indicate that you wish to Create a SQL statement using the wizard.

Create a New S0QL Statement. ll

You may choose between creating a custom S0L statement ar creating a SQL statement
using the wizard. For SGIL statements requiring multiple tables, create a custom SGL
statement.

O Create Custom SQL statement

@® Create a SQL statement using the wizard

Statement Type:

SELECT [~]

[ |[ Next ][ Finish ][ Cancel

5 Choose SELECT as the Statement Type.
6 Click Next to display the dialog which allows you to choose a table from which to select your data.

Create a New S0L Statement. ll

Choaose one table and the calumns within the table that you want the SELECT statement t
return.

Tables and Columns:

[ O AgResources [~]
[#- O InventorySystem
=} @ ProductSystem
SKU .
NAME
DESCRIPTION
I MANUFACTURER
CILISTPRICE
] IMAGEFILE
] IMAGEHEIGHT
] IMAGEWIDTH

[ ack

7 Select the table and columns used for the SELECT statement by checking the radio button check
boxes associated with the required columns of the table you wish to use. You will notice that if you
hover your cursor over a column, descriptive information about that column, such as its TYPE and
whether or not it can be a NULL field appears.

[<]

[ Finish ][ Cancel ]

NOTE: You can select or deselect all the columns in a table by checking or unchecking the box at
the table level.

8 Click Next to bring up another dialog, which allows you to select columns to use in your WHERE
statement to filter the results of the SELECT statement.
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Create a New S50L Statement. 5[

Choose the Column(s) wou wantto use in the SELECT staterment's WHERE clause to filter
the result set.

Tables and Columns:

=} @ ProductSystem
SKU
I NAME
[/ DESCRIPTION
] MANUFACTURER
[CJLISTPRICE
[CJ IMAGEFILE
[ IMAGEHEIGHT
CJIMAGEWIDTH

[ Back ][ Next ][ Finish ][ Cancel]

9 Click Next to move to the final dialog, in which you specify the Target Message Part and XPath
placement for the results of your SQL Statement.

Create a New S0L Statement. X|

Selecta Part and enter the Target XPath for the result. If multiple rows are returned, the
¥Path must include a Row Target{e.q. RESULTINFOMROYY). Choose the options as
required.

Target

(®) ¥Path: Putput [~] () Expression:

[RESULTINFO/ROW e

Options
Create element names as column names
Create elements if column is null
[ Include datatype info in element attribute

[C] Generate Row numbers

[ Back ]| I 3J(_Cancet ]
You can either specify an XPath, or select Expression to go to the ECMAScript Expression Builder
and

Optionally, you may also choose to:
o Create element names as column name.

+ Create elements if column is null. This creates XML elements with empty content if the
column returned has no data.

+ Include data type info in element attribute. This creates an attribute for each element
indicating the data type of the result column.

+ Generate row numbers (if applicable).
10 Click Finish to create the action and return to the JDBC Component Editor.

WHERE Clauses

The execute SQL SELECT statement is now displayed and highlighted in the Action Model. When focus
is on this new action, the Native Environment Pane displays a two-tabbed dialog which includes a
WHERE tab and a Result Text tab. WHERE will be visible by default. This tab will be used to filter the
result set.
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| WHERE | Result Text |

g == {gp ==} | Value |

‘ = [v| LIKE
Mot Equal To
Less Than
Greater Than
g @ Ej r{ﬂ G == Less Than or Equal Te
[=-- SampleJDBCInventoryl ool = Greater Than or Equal Te
ﬂ”’ LOG "rn™ + "Comg, LIKE Search for a Pattern o Log Leveld

L wecute SOL SELE BETWEEN An Inclusive Range R
ﬁ MAP $TempiNVEN] NOT BETWEEM An Exclusive Range US/SKU J
n & d Im " (= 1 1T 3

i tx AN A L OO T AT e AT o P

> Filtering the resultset using the WHERE tab:

1

4

Select the Columns you wish to filter using the dropdown menu. This list is populated according to
the columns you chose in step three of the wizard. You may select one or more columns with which
to filter the list. To add a column to the filter for the result set, click on the + icon. To delete a
column, click the - icon. Columns can also be selected by group. To add a group, click the {+ icon.
To delete a group, click the -} icon.

Select a Relation from the dropdown list. Examples for all these relational operators can be found
at http://www.w3schools.com/sql/sql_where.asp.

When using the LIKE operator, the % symbol can be used as a wildcard character representing any
number of missing characters at the beginning or ending of your matching pattern. Text values
should be surrounded by single quotes, though most databases will also accept double quotes.

It is important to note that the BETWEEN...AND operator can be interpreted differently by
different databases. With some, “between” is literal and only values in between your test cases will
be selected. Some databases will include the test cases in your result set also. Some include the first
case but not the last, and vice versa. In general, with SQL, you should follow the advice of that
famous television lawyer and “Never ask a question you don’t already know the answer to.”

For Value, either a constant or an expression can be entered. You may also drag and drop fields
from your XML Message Parts to create an expression.

The Logical dropdown menu allows you to create more complex WHERE clauses using And/Or
logic. Or, you may complete the clause by selecting End.

Once you have adjusted your WHERE clause to filter your results appropriately, you will see the
completed SQL statement in the Action Model.

If you open the Result Text tab, you will be able to see the text of the SQL and the results produced by
running the query.
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¥ exteNd Composer: TutorialEnd [IDBC: SampleJDECInventoryLookup] =[Ol x|

File Edit View Component Action Animate Tools Window Help BO - & x
D@8 Yy00X QS Novell

|%@ SampleJDBCInventoryLookup ]
WHERE I Result Text ]

EXECUTED:
SELECT SKU, MNAME, DESCRIFTION FROM ProductSystern WHERE SKU="LORE437"

SkU MARE DESCRIFTION

LORS437 Cherry Bookcase Features premium grade cherry in a scratch and dent resistant finish.

DEEEEN
pleJDBCImentond ookup
ﬁ” LOG ™rin" + "Component starting...” + "\rin" TO System Output using Log Level &
Lo/ zecute SQL SELECT: SELECT SKU, NAME, DESCRIPTION FROM ProductSystem WHERE SKU=Input. XPath("PRODUCTREQUES
£p MAP $TempINVENTORYSTATUS/SKU TO $0utput INVENTORYSTATUSSKU
ﬁ WAP $TempiINVENTORYSTATUS/CATEGORY Via Code Table Map IrventoryDisplay' TO $OutputINVENTORYSTATUSICATEGORY
ﬁ MAP $TempINVENTORYSTATUS/STATUS TO $0utput INVENTORYSTATUS/STATUS
ﬂ” LOG ™rin" + "End of Component.” + *ir'n"™ TO Systern Output using Log Level 5

T B
Peady

The SQL DELETE Statement
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Delete statements in SQL are used to delete entire rows from tables. If you wish to delete, null out or
otherwise modify individual column values within rows in a table, you should use the MODIFY
command (described below). The steps to follow to create an SQL DELETE statement are fairly similar
to those for creating an SQL SELECT statement.

> To create an SQL DELETE Statement action using the wizard:
1 Create or open a JDBC Component.

2 Highlight a line in the Action Model where you want to place the SQL Statement action. The new
action will be inserted below the line you highlight.

From the Action menu, select New Action, then SQL Statement.

Select DELETE for your Statement Type.

3

4 Indicate that you wish to Create a SQL statement using the wizard.

5

6 Click Next to select the table from which rows will be deleted using the DELETE statement.

Create a New S0L Statement. il
Selectthe table frome which DELETE staterment to delete raws.

Tables and Columns:

[+ O AgResources [~]
= O InventorySystem
=} @® ProductSystem

Finish ][ Cancel ]

Back [
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Only one table can be checked at a time. In the case of DELETE, you will not be able to select
individual columns at this point in the wizard. This screen is for table selection only, and the
columns are all selected and grayed out, indicating that they will all be available for selection in the
next dialog of the wizard.

Click Next to open the next dialog, from which you will select the column(s) which will be used by
the DELETE statement’s WHERE clause to filter the records which will be deleted.

Create a New SOL Statement. x|

Choose the Columnis) you wantto use in the DELETE staterment's WHERE clause.
Warning: Ifyou do not specify a WHERE clause, ALL recaords will be deleted.

Tables and Columns:

=} ® ProductSystem
SKU
CINAME
I DESCRIPTION
[ MANUFACTURER
CJLISTPRICE
[ IMAGEFILE
[ IMAGEHEIGHT
[ IMAGEWIDTH

[ Back ]| |[ Finish ][ Cancel ]

Click Finish to create the new action and display it in the Action Model. As described above in the
SELECT statement, the WHERE tab will be displayed. Use the WHERE filtering (described in
“WHERE Clauses” on page 28) to complete your SQL Delete statement. The Result Text tab
shows the text of the SQL and the results produced by running the statement.

The SQL INSERT Statement

Insert statements in SQL are used to insert entire rows into tables. If you wish to insert or otherwise
modify individual column values within rows in a table, you should use the MODIFY command
(described below). The steps to follow to create an SQL INSERT statement are also fairly similar to those
for creating an SQL SELECT statement.

> To create an SQL INSERT Statement action using the wizard:

1
2

o g b~ W

Create or open a JDBC Component.

Highlight a line in the Action Model where you want to place the SQL Statement action. The new
action will be inserted below the line you highlight.

From the Action menu, select New Action, then SQL Statement.
Indicate that you wish to Create a SQL statement using the wizard.
Select INSERT for your Statement Type.

Click Next to select the table(s) into which rows will be inserted by the INSERT statement. At the
same time, select the columns which will be provided with new data by the statement.
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Create a New SOL Statement. x|

Selectthe table into which a new row will be inserted. Selectthe columns in the table for
which the INSERT statement will provide data.

Tables and Columns:

[} O AgAccessRights

- O AgAgents

- O AgContents

[} O Aglnfo

[*- O AgResources

=}~ @ InventorySystem
SKU
CATEGORY
ONHAND
COST
CJSTATUS [~

(pack )

7  Click Finish to insert the new SQL Insert Statement into your Action Model and return to the
Component Editor.

[>]

][ Cancel ]

The Native Environment Pane displays two tabs: Column Values and Result Text. Column Values will be

displayed by default.
¥ exteNd Composer: TutorialEnd [JIDB! mplelDBCInventorylook ] 3
File Edit View Compornent Action Amimate Tools Window Help EHE - F x
D@8 yJ0X @S Novell
%& SampleDBCInventory Lookup ]
@ Input  |Data B x| |[ Coumn Values | Result Text |
Table:  InventorySystem
hitp: it COMpOSer.com
LORS437 Column alue |
SKU Cutput ¥XPath " INVENTORYSTATUSISKU B -
CATEGORY 1 @ -
OMHARND 200 @ -
COST 275 -
@ Output . Bx 174

E <> INVENTORYSTATUS

Loreds’ @ Ml CR (B2 @ I
=} Sample JDBC Inventond_ookup
ﬁ’ LOG "™rn" + "Component starting...” + "rn" TO Syste
L xecute SOL INSERT: INSERT INTO InventorySystem (
g MAP $TempINVENTORYSTATUS/SKU TO $0utput.|'lNVE|Z|

]

|

|SOL|tpL|t SIMVENTORTYSTATUS /STATLIS

Specifying Column Values

The Column Values pane displays a table with two columns. The first presents a list of the columns
selected during the final step of the SQL Insert wizard. In the second column, you will define the values
for the columns of the row to be inserted. You also have the ability to drag and drop data from a Message
Part to the Value column, as shown in the SKU example above.

As always, the Result Text tab shows the text of the SQL and the results produced by running the
statement. You will notice that Integration Manager automatically surrounds non-numeric data with
single quotes.
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Column Valles | Resuilt Text ]

EXECUTED:
INSERT INTO InventorySystern (SKU, GATEGORY, ONHAND, COST) WALUES (LORS4ST', 1, 200, 275)

SALCODE=0
UFDATECOUNT =1

The SQL UPDATE Statement

Update statements in SQL are used to modify data within the rows and/or columns of a table. The steps
to follow to create an SQL UPDATE statement are also fairly similar to those for creating an SQL
SELECT statement.

> To create an SQL UPDATE Statement action using the wizard:
1 Create or open a JDBC Component.

2 Highlight a line in the Action Model where you want to place the SQL Statement action. The new
action will be inserted below the line you highlight.

From the Action menu, select New Action, then SQL Statement.

Select UPDATE for your Statement Type.

3

4 Indicate that you wish to Create a SQL statement using the wizard.

5

6 Click Next to select the table(s) and columns to modify with the SQL statement.

Create a New S0L Statement. x|
Select the tahle and columnis) that will be madified by LIPDATE staterment.

Tables and Columns:

[+ O AgAccessRights

- O Aghgents

- O AgContents

[*- O Aginfo

- C AgResources

=} @ InventorySystem
SKU
CATEGORY
ONHAND
COST
[ STATUS

[ Back |[iRexi..i|( Finish |[ Cancel |

7 Click Next to bring up the final dialog, which allows you to select which columns will be used by
the WHERE clause of the Update statement.

[2]

w
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Create a New S0L Statement. x|

Choose the Columnis) you want to use in the UPDATE staterment's WHERE clause to filtel
the result set.

Tables and Columns:

= @ InventorySystem
SKU
[l CATEGORY
] ONHAND
ClcosT
CIsTATUS

[ Back ]| |[ Finish ][ Cancel ]
8 Select the appropriate columns and click Finish to complete the action and add it to the Action
Model.

Just as with the SELECT and DELETE commands, the Native Environment Pane will display a Where
tab and a Result Text Tab. In this case, though, it will also display a Column Values tab as seen with the

Insert command.

Use the Where tab to filter the record set to be updated as demonstrated in “WHERE Clauses” on
page 28. You may select the columns and define the criteria for those columns in order to update only the

desired records.

WHERE rCO|LIITII'I Values]r Result Text]
9 = {gp =}

‘ISKU [w| = | ath("INVENTORYSTATUSISKUY B - End $

Tab to Column Values to provide the values for each of the columns to be updated. Updating Column
Values is demonstrated in “Specifying Column Values” on page 32.

WHERE I Column Yalues || Result Text
Table: InventorysSystem

Column Walue |
S 'SUEZ2234" E -
CATEGORY 2 @ -
CMHAMD 44 E -
COST 3000 @ -

As always, the Result Text Tab shows the text of the SQL and the results produced by running the
statement. You will notice that Integration Manager automatically surrounds non-numeric data with

single quotes.
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WHERE || Column Values | Result Text]

EXECLUTED:

UFDATE InventarySystem SET SKU = 'LORB437, CATEGORY = 2", ONHAND =
266, COST =12, STATUS = 1"WHERE SKU="LOR2437'

SQLCODE=0
LPDATECOUMNT =10

Editing a SQL Statement Created with the Wizard

Once you have created your SQL statement, you may find that you need to edit it. This is a two part

process. Begin by double-clicking on the EXECUTE SQL action in the Action Model. This will bring up
a tabbed dialog, as shown below.

Edit SOL Statement x|
|' Table and column selection panel ][ WHERE clause column selector |[ Result Map Properties |

Choose one tahle and the calumns within the table that yvou want the SELECT staterment to
return.

Tables and Columns:

[#- O AgAgents

[+ O AgContents

[*- O Aginfo

[} O AgResources

=} @ InventorySystem
SKU
CATEGORY
ONHAND
COST
STATUS

1 C ProductSystem

[NE

[<1

5

These tabs allow you modify the basic Table, Column and Target selections for the SQL Query. The
number of tabs will vary according to the type of SQL Statement you are editing.

+ The Table and column selection panel tab is available for all SQL statement types. It allows you
to modify the tables and/or columns you had chosen to use in your SQL query.

+ The WHERE clause column selector tab is available for the SELECT, DELETE and UPDATE
statement types. Use this tab to modify the columns you had chosen to use for your Where clause.

+ The Result Map Properties is available only for SQL SELECT actions created using the Wizard.
Here you can modify the Target location for the results of your query.

Once you have edited the information in these tabs, you may need to further modify the SQL Statement
using the additional tabs available when the item in the Action Model is clicked on a single time, or after
you have clicked on OK in the Edit SQL Statement tabs, described above.

Back in the Native Environment Pane, you will see a screen that resembles the following.

|§ WHERE " Column Values |[ Result Text |
B == g ==}

‘ s M = #|foressr

Again, the number of tabs shown will vary according to the type of SQL Statement.

+ The WHERE tab is available for all SELECT, DELETE and Update SQL Statements prepared
using the wizard. Here you can modify the filter chosen to limit your query.
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The Column Values tab is available for INSERT and UPDATE queries. Use this tab to modify the
values you originally designated as being inserted or changed as a result of your SQL statement.

The Result Text tab is available for all SQL Statements. It shows the query that was executed and
the results it produced.

Creating an SQL Statement Manually

The manual creation of SQL statements for use in JDBC Components is done inside the Query/Result

Mapping Pane.
¥ exteNd Composer: T utorialEnd DBC: InventoryLookup] [[o[x]
File Edit View Component Action Animate Tools Window Help EO - & x
O=zE8E8>0 X QS Novell
2 ‘2";‘ pata 50L Statement | Result Maping || Result Text]
= OPRO‘ e Data Operators/Keywards:
' xminfhitp:/ Lomp "
7 AgiccessRights 7S0L
&3> SHLORSA3T g S-Math uery esu t
- AgContents £ Relational - .
5 Aginfo 5 Logical M P
+ AgResources & Fancions apping Fane
- InventorySystemn
I Output .
6L Statement [ Exeouts Az Prapared
SELECT * FROM InventorySystem WHERE SKU ="Input XPath("F RODU CTREQUE STISKU'"Y' SQ L State me nt
DEBE2I
[ETeme Data pntoryl ookup <
=-<> INVENTOR {7 LOG "rin" + "Component starting...” + “\'n" TO Systerm Outout using Log Level §
1 ::SKU BELLCACIIN PV o te SOL: SELECT * FROM InventorySystem YWHERE SKU =“Input. XPath{"PRODUC
b CATEGT
<> onHARD g WAR $Temp INVENTORYSTATUS/SKU TO $OutputINVENTORYSTATUS/SKU -
| <> COosT 278 &5 MAP $TempINVENTORYSTATUS/CATEGORY Yia Cods Tablz TO $OUtpUtNVENTORYST _
<> STATU[OuL of Stockd | 4] | _,l—l
jaction: Execute SQL: SELECT * FROM InventorySystern YWHERE SKU ="Input XPath('FRODUCTREQUESTISKUY

If you are editing a previously created action model that already contains SQL Statement actions, you can
make the Query/Result Mapping Pane come into view simply by selecting (clicking on) any existing SQL
Statement action. Otherwise, you will create an SQL Statement action.

> To manually create an SQL Statement action:

1
2

Create or open a JDBC Component.

Highlight a line in the Action Model where you want to place the SQL Statement action. The new
action will be inserted below the line you highlight.

From the Action menu, select New Action, then SQL Statement.

Indicate that you wish to Create a Custom SQL Statement. The Query/Result Mapping pane
appears in the Native Environment pane of the JDBC Component Editor window, as shown above.

Building an SQL Statement Manually

Building an SQL Statement manually involves bringing together data, operators, and keywords.

> To build an SQL Statement:

1
2

Place the cursor in the SQL Statement control box in the Query/Result Mapping pane.

Expand the Data columns and/or the Operator/Keywords by clicking the plus signs. The
illustration below shows Data and Operator/Keywords trees look like with several parent nodes
expanded.
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S0L Staterment ResultMapping' ResultText'

Operatorsikeywards:

|| =-saL -
SELECT

E-INSERT

=-Relational

----- DESCRIPTION

Less than

------ MANUFACTURER

..... LISTPRICE Greater than | |

..... IMAGEFILE = Less or equal

..... IMAGEHEIGHT | = Greater or equal

----- IMAGEWIDTH hd Elff L ;I
S0L Statement: [ Execute #s Prepared

SELECT * FROM InventarySystem WHERE SKU ="Input xPath("PRODUCTREQUESTISKL"Y'

Double-click each Data column and/or Operator/Keyword that you would like to add to the SQL
Statement box. When you double-click an item, it automatically appears in the SQL Statement
box at the insertion point.

Optionally, you may drag elements from an open DOM tree (e.g., the Input DOM pane) into the
SQL Statement box.

Optionally check the Execute as Prepared checkbox. (See “Prepared Statements™ on page 26.)

Building an Example Query

Here is an example SQL statement:

SELECT * FROM ProductSystem WHERE SKU = ':Input.XPath ("PRODUCTREQUEST/SKU")';

In order to build this statement, the component must satisfy the following:

*

The component must be able to use a (previously defined) connection resource to connect to the
database

The database must have a table called ProductSystem that has a column called SKU

The component must have a template containing a sample XML document with a root element,
PRODUCTREQUEST, that has a child element named SKU

This example statement, in plain English, means:

“Select all columns from the database’s ProductSystem table where a record’s value in column SKU is
equal to the content of the Input DOM’s PRODUCTREQUEST/SKU element.”

> To build the example statement:

© 0 NO G A ONa=

Expand the SQL tree in the Expression builder and double-click SELECT.
Double-click * in the Expression Builder.

Double-click FROM in the Expression Builder.

Type ProductSystem.

Double-click WHERE in the Expression Builder.

Type SKU =.

Select SKU in the Input DOM and drag it into the SQL Statement control.
Optionally type a semicolon ( ; ) at the end of the SQL Statement.

Select File>Save. The Query/Result Pane should look like this:
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Mapping Results into the Output DOM
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When you have created your SQL Statement manually, you must use the Result Mapping pane to select
where to place the rows and columns of your results into the XML Document tree.

> To use Result Mapping:
1 Select the Result Mapping tab in the Query/Results Mapping pane. The Results Mapping pane

appears.

SQL Statement ResultMapping | ResuItTextl

Result Row Placement
Enterthe XML element to place results under:

frems =]

[INVENTORYSTATUS 74

= |7 Create element names as column names
|7 Create elements if column is null
|_ Include datatype info in element attribute

I_ Generate Row numbers

= Custom Column/RondGroup |
|_ Stored Procedure mapping |

2 Under Result Row Placement, select the destination Part to which you would like the result of the

SQL query mapped.

3 Next, select the Part element under which you’d like each result row to appear. If an appropriate
Part is not listed, you may add another XML template using the File>Properties>Messages dialog
from the menu. If a Part is not visible, go to View>XML Documents>Show/Hide.

4 Sclect options as follows:

Default Result Mapping: Choose the first radio button for standard Column/Row/Group mapping:

+ Create element name as column name.

+ Create elements if column is null. This creates XML elements with empty content if the

column returned has no data.

+ Include data type info in element attribute. This creates an attribute for each element

indicating the data type of the result column.

+ Generate row numbers (if applicable).

Custom Result Mapping: Choose the second radio button, Custom Column/Row/Group, to perform

custom column, row, or group mapping (see Chapter 5).

Stored Procedure Mapping: Choose Stored Procedure mapping to map data returned from stored

procedures. (see Chapter 6).
5 Sclect File>Save.
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Editing a Manually Created SQL Statement

To edit a SQL statement once you have created it manually, simply click on the EXECUTE SQL action

in the Action Model.
[ 5QL Statement | Result Mapping | Result Text |
Drata: OperatorsiMeywords:
+}-Aglnfo [~] |5 saL (~]
|;|"'AQRESDUTCBS E'"'SELECT i
[+ InventorySystem | El---DELETE
[ -UPDATE
[+]-INSERT
[+}-Math
| |- Relational

M
SQL Statement: [_] Execute As Prepared
FELECT* FROM InventorySystern WHERE SKU

|j| EI---Lugical |

“nputXPath("PRODUCTREQUESTISIKLY

+ Use the SQL Statement Tab to edit the Text of your SQL statement manually or use the methods
above to change your selections of Data, Operators and Keywords.

+  Use the Result Mapping Tab to modify the target placement for the returned data.
+ Use the Result Text Tab to show the query that was executed and the results of the query.

Executing the SQL Statement

After you have built the SQL Statement, either manually or using the wizard, click the Execute button to
run it.

Eer: TutonalEnd [JDBC: Inventorylookup]
Component  Action Ani Bgols  Window  Help

=0 48 X4
£ —— | SO Statem® el Mapping | Result Tex |
Data: Operatorsikeyawo
Qdhwnani cOMMRIE e d el
RE437 +-AgResources Ql
= InventorySystem E t +-SELECT
SKU Xxecute —I-DELETE
catecory  button FROM
ONHAND WHER
COST +-UPDATE
STATUS +-INSERT
P-|| = ProductSystem 4] Tath

Checking the Results

You can check the results of your SQL statement by looking at the data retrieved in the familiar row and
column format. To do so, click the Result Text tab. This tab is available for all SQL Statements, whether
created manually or using the wizard.
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[‘saL statement | Result Mapping | Result Text ]

EXECUTED:
SELECT * FROM InventorySysterm WHERE SkU ='LORE437

Sk CATEGORY  OMHAND COsT STATUIS

LORE437 1 a 275 Out of
Stockion re-arder

If the query result returned by the SQL statement looks correct, you can continue designing your
component’s Action Model. Otherwise, you can return to the SQL Statement tab and debug your SQL as
necessary.

Using Stored Procedures

Many RDBMS vendors provide the ability to execute procedural code stored in the RDBMS system.
Using these stored procedures allows for high-performance interfaces that are independent of the
underlying table implementations.

Using stored procedures can be helpful in controlling access to data. User access to data can be limited to
the scope of the stored procedure. Limiting access to data with stored procedures preserves data integrity
by insuring data is entered in a consistent manner. Stored procedures also improve efficiency. They’re
memory resident, which speeds execution. Their use decreases network traffic. Productivity is improved
via their use since stored procedures only need to be written and debugged once but can be reused by
many.

While often used interchangeably, for the sake of discussion we’ll differentiate between the terms
Procedures and Functions. A Procedure is a subroutine that doesn’t necessarily return any data but may
via the call’s parameters or as external result sets. A Function, on the other hand, always returns
something. Both Procedures and Functions can pass Parameters.

Novell Integration Manager allows you to map parameters to stored procedures and functions, execute
stored procedures and functions and map returned data to DOM/node combinations.

Syntax Requirements

40

In order to package the Procedure or Function call correctly, Integration Manager requires certain
formatting conventions be followed. For example:

{ — indicates that a call to a Function or Procedure follows
} —indicates the end of a call to a Function or Procedure

The syntax for procedures and functions support parameters which may be Expressions, Placeholders or
Constants.

Expression: Expressions may be used to pass variable input data to a procedure or function. Expressions
used as parameters in procedure and function calls are preceded with a colon (:) and enclosed in single
quotes. (e.g. ‘:<variablename>’).

Question Mark: Question Marks ( ? ) may be used as parameters and serve as placeholders to which the
procedure returns data. A question mark is also used for the result in a function.

Constant: Constants are used to pass input data in procedures and functions but, unlike expressions or
placeholders cannot be used to accept returned data. Literal values are enclosed in single quotes.
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Rules for Stored Procedure Parameters
Stored procedures may have Input Parameters, Input/Output parameters and Output Parameters.

Input Parameters: Input Parameters pass data to stored procedures. Input Parameters may be Constants
or Expressions.

Input/Output Parameters: Input/Output Parameters pass data to stored procedures and accept data
returned from stored procedures. Input/Output parameters must be Expressions.

Output Parameters: Output Parameters accept data returned from stored procedures. Output parameters
may be either an Expression or a Question Mark as a placeholder.

Using Procedures and Functions in a JDBC Component
For all the examples below the following steps should be executed.
* Add a new SQL action

* Execute as Prepared is set to true (check the checkbox; see “Prepared Statements” on page 19).

NOTE: For mapping the results of stored procedures, see Chapter 6.

Syntax for running a Procedure from within Integration Manager

Procedures that do not return a value:

{ call [<packagename>.]<procedurename>|[ ([paraml, param2..,paramn])]}
Example:
{ call composerDemoPackage.spl withParams(‘12345’,'George’) }

Procedures that return a result set:

{ call [<packagename>.]<procedurename>|[ ([paraml, param2..?....paramn])]}

where ? is a parameter to which the result set is returned. A result set may also be returned to other
parameters which contain Expressions.

Example:

{ call composerDemoPackage.sp withParams('93324', ‘:FirstName’, ?)}

In this example ‘93324’ is a constant, ‘:FirstName’ is an Expression and ? is a placeholder.

NOTE: Only Oracle returns result sets as parameters. Non-Oracle RDBMSs may return result sets but,
not as parameters.

Backward Compatibility for Oracle Procedures that return a result set:

Prior to version 4.0, Integration Manager provided support for Oracle Procedures that return result sets
as parameters. To do so, Integration Manager (prior to version 4.0) required the user to specify the Oracle
Cursor Position within the procedure call. The pre-Integration Manager 4.0 syntax included ocp:n —
where ocp stands for Oracle Cursor Position and :n indicates which parameter contains the cursor. This
syntax was used in pre-4.0 versions of Integration Manager and is maintained in version 4.0 and greater
for backward compatibility.

{ call [<packagename>.]<procedurename>|[ ([paraml, param2..0Cp:X....paramn])]}
Example:
{ call composerDemoPackage.sp withParams ('93324', ‘Melissa’, ocp:3)}
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Syntax for Calling a

NOTE: The contents of the result set will be returned in the same manner as a standard SELECT
statement. The results will be automatically be mapped to the selected XML Document. The defaults are
Output as the Document and RESULTINFO/ROW as the XPath location.

Function from within Integration Manager

Functions that return a result set:

{ ? = [<packagename>].<functionName>|[ ([paraml, param2..,paramn])]}
Example:
{ ? = call composerDemoPackage.fn justOneReturn( ) }

Backward Compatibility for Oracle Functions that return a result set:

To provide backward compatibility with pre-4.0 versions of Integration Manager, the following syntax
will continue to be supported in Integration Manager 4.0 and greater.

{ ocp:1 = [<packagename>].<functionName>[ ([paraml, param?2..,paramn])]}
Example:
{ ocp:1 = call composerDemoPackage.fn justOneReturn( ) }

Other Methods of Calling Functions for Specific Tasks
You may call any function that does not update the database from within a select statement.
Example:

select fn addMin(4,6) "Sum" from dual

To use a function that does not return a result set but updates the database, call it from within a function
that does return a result set — see the example fn_callAddMin

Example:

{ ? = call composerDemoPackage.fn callAddMin (22,44 ) }

Colons in SQL Statements

Colons are special characters in SQL Statements, because Integration Manager treats colons as markers
indicating the presence of ECMAScript immediately to the right. In the above action, the SQL Statement
includes the string

‘:Input.XPath (“"PRODUCTREQUEST/SKU”) '

which contains a colon followed by an ECMAScript expression involving the XPath() method. Without
the colon, the string would be evaluated as a string-literal. With the colon, it is evaluated as an
ECMAScript expression.

NOTE: If you need to use colons as literal values inside SQL Statements, escape every occurrence of a
literal colon with a backslash. Otherwise, you may see errors.

42 JDBC Connect User’s Guide



The SQL Batch Action

Start Batch

Most database drivers allow batch execution of SQL statements in order to minimize demand on
connection resources. For example, a user may want to insert data into a table in one database and delete
data from a table in another database, all in one round trip. This is possible with the SQL Batch action.

SQL Batch actions allow you to specify that a particular group of SQL Statement actions should be
accumulated into a single batch and transmitted to the database as a unit.

NOTE: SELECT operations may not be used in batches. Use only INSERT, DELETE, and UPDATE
statements.

To access the SQL Batch action, right-click inside the action pane and choose New Action > SQL Batch
as shown below.

Action

SEL Staterment [

‘ Disahle Advanced C
Diata Exchange

FPracess »
Repeat »

Comment...
Coamponent...

. Decision...
Declare Alias..
Function...
Log...

Map...
Send Mail...

Swyitch...

There are three SQL Batch commands, each of which places a new action in the action model: Start
Batch, Execute Batch, and Discard Batch.

You must tell Integration Manager where the beginning of a batch occurs, by placing a Start Batch
statement before the first SQL Statement in a series of statements that you want to group. This command
sets a checkpoint for rollback purposes (in case the batch does not finish normally).

From the first occurrence of this command until the next occurrence of an Execute Batch command (see
below), SQL Statements are merely accumulated, rather than executed. Execution of a batch does not
occur until an Execute Batch command is reached.

Regular (non-SQL) actions, such as Map and Function actions, are not affected by Batch operations. If
you place Map actions, Function actions, or any other non-SQL actions within or after a group of batched
SQL Statement actions, those actions will execute before the SQL Statements in your batch, because the
batch cannot execute until an Execute Batch is reached.

Performing JDBC Actions 43



Execute Batch

Discard Batch

An Execute Batch command causes all SQL Statements in a batch to be sent, as a unit, to the database.
(If no Execute Batch command is issued, none of the SQL Statements in the preceding batch will get
executed.)

An Execute Batch statement can be placed immediately after a batch of SQL Statement actions, or it can
be placed at some point downstream of the batched actions (possibly in one branch of a Decision action).
In other words, you can create a batch in one location and execute it, conditionally, from another location
in your action model.

The Discard Batch command is a memory-de-allocating command that causes the previously held batch
to go out of scope. It frees the memory held by the preceding batch.

Ordinarily, when an SQL batch executes without error, the batch is discarded automatically after it
executes and there is no need to issue an explicit discard. You would use Discard Batch when you have
an action model that contains two or more sequential SQL batches (each with its own Execute Batch
command) wrapped in Try/On Fault statements. The need for the Discard Batch arises when one of the
upstream batches executes abnormally (generating an exception). In order to continue to another batch,
you need to purge the previous batch from memory (with a Discard Batch in the On Error branch of the
“Try” action). Failure to use Discard Batch under these conditions would cause the next Start Batch to
throw an exception. This scenario is shown in the illustration below.

TRY
Start Batch
(SQL Statements)
Execute Batch
ON FAULT
| Discard Batch |

Start Batch &

(SQL Statements)

TRY

Execute Batch

ON FAULT —+
Discard Batch

In the case depicted above, where there are two SQL batches (each enclosed in a Try/On Error action),
failure to include a Discard Batch action in the error branch of the first Try will cause the next Start Batch
to throw an exception (assuming the first batch fails).

In summary: When two or more batches will execute sequentially, wrap each in a Try/On Error action and
include a Discard Batch command in the On Error branch of each.

For action models in which there is only a single SQL batch, Discard Batch is not necessary. After normal
execution of a (single) batch, memory allocated to the batch is released automatically; and if the batch
returns an error, the batch will go out of scope (and be garbage-collected) when the component itself goes
out of scope.
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Creating Batch actions

Batch actions are created using the SQL Batch menu command (available from Action > New Action >

SQL Batch in the JDBC Component Editor main menu, or via New Action > SQL Batch in the

contextual menu).

> To create a SQL Batch action:

1  Place the cursor in a line preceding the group of SQL Statements that you want to batch. Then press

the right mouse button and select New Action > SQL Batch. The Batch setup dialog appears.

Batch E2

Choose an option to either Start, Execute, or Discard a
SaL Batch. Wyhile in batch mode, all SQL statements
except for a SELECT are included in the Batch.

¢ Start Batch
" Execute Batch fends batch)

" Discard Batch fends batch)

Help OK Cancel

2 Choose the Start Batch radio button to insert a Start Batch command in your action model.

Otherwise, choose Execute Batch or Discard Batch, as appropriate.

3 Click OK to dismiss the dialog. A new action appears in your action model.

JDBC-Specific Expression Builder Properties

SQL queries can result in certain status and/or error values being returned (for example, the number of

records that were changed by an Update). Often, it is useful to be able to reference these values in

ECMAScript expressions. The Expression Builder pick list (in the top portion of the Expression Editor

window) contains properties that are specific to JDBC Actions involving SQL: namely, SQLSTATE,

SQLCODE, and UPDATECOUNT. (See panel below.)

¥ Source Expression
Yariables:
-2 Qutput

Functions/Methods:
#-Custom Scripts
i#-Document
F-ECMASCript

- <> PROJECT -Extended ECMAScript
#- <> Repeat Miases | | F-JDBC
#- <> Node Aliases =-8QL
- SOLCODE
~SQLSTATE
~UPDATECOUNT
= LASTSQL

Cperatars:

I-Relational
[#-Logical
- String

"kttt composer comftutarialfproductresponse”

Help Validate OK

Cancel
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Using Other Actions in the JDBC Component Editor

In addition to the SQL Statement action, you have all the standard Basic and Advanced Integration
Manager actions at your disposal as well. The complete listing of Basic Integration Manager Actions
can be found in Chapter 7 of the Novell Integration Manager User s Guide. Chapter 8 contains a listing
of the more Advanced Actions available to you.

Handling Errors and SQL Messages

SQL returns certain coded values when errors occur (i.e., no record was found in a Query) or as a report
on the result of certain actions (i.e., how many records were changed by an Update). These results appear
on the Result Text tab as three special variables labeled:

+ SQLSTATE
+ SQLCODE
+ UPDATECOUNT
+ LASTSQL

These variables are available to ECMASecript functions you may write and can be used for error handling
within your JDBC component. For instance, you can create a Decision action to process after an SQL
statement. Based on the value returned in the UPDATECOUNT variable, you can choose one or the other
set of actions in the two branches of the Decision action. Likewise, error information contained in
SQLSTATE or SQLCODE (which are standard SQL status variables) can be used to branch to
appropriate recovery logic in case of error.

The LASTSQL variable is an exteNd-defined string variable which contains the last SOL statement to
actually execute in the component in question. Logging the value of this variable can be useful for
troubleshooting.
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Using Custom Result Mapping

The following sections describe the similarities and differences between default and custom result
mapping for the Execute SQL action. Custom mapping features are described in detail.

About Default Result Mapping

The mapping of data returned from an Execute SQL action is determined by specifications on the Result
Mapping tab in the SQL Mapping pane. The two Result Row Placement controls allow you to determine
where in the target document to place the result set data. The drop down list specifies the Message Part

or Repeat alias context and the Expression edit box specifies the XPath location within the Context.

The Context is either the name of a Part in the component or the name of a Repeat alias already specified
in the component (where the Repeat alias itself represents a Message Part context and XPath location).
The Expression edit box specifies an XPath, the last element of which acts as the parent element for the
returned results and will receive the data. The last element that receives the data is called the Row Target.
If multiple rows are returned, then multiple Row Targets will be created. Each column returned in a row
will appear as a child element of each Row Target.

¥ extend Composer: TutorialEnd [IDBC: SamplelDBCInventorylookup] 3 _1Oi x|
Fie Edit View Component Action Animate Tools Window Help EO -8 x
DS Y00 X QS Novell
@ Output Data B x| [saLstatement | Resuit Mapping | Resut Text |
[=)-<> RESULTINFQ
Pt Result Row Placement
Ch<>ROW
Enter the XML element to place results under
<>k CHR11T -
<> CATEGORY |3 Lt ]
<> ONHAND 0
<>cosT aga [RESULTINFOIROWY 4
<> STATUS Qut of Stockon re-order)
[ <> Rowy
5 <> Row @ [ Create element names as column names
3 <> Row [ Create elements if calumn is null
[ <> RO [ Include datatype info in element attribute
[ <> Row ] Generate Row numbers
[ <> ROy ET—
5 <> Row O Custom Column/Row/Group | |
\gl <> Row [ Stored Procedure mapping ‘7‘
[ <> ROy -

DEBRE2S I

SampleJDBCInventoryLookup
ﬁ” LOG ™r'n™ + "Component starting..." + "irin" TO Systern Output using Log Level 5
Lo N xecute SOL: SELECT * FROM InventorySystem

>

[<]

<TT ]

Ready

By default, the Row Target is named “ROW” and is a child of a root element named
“RESULTINFO,”and the results are written to Output, as shown above. Notice that no checkboxes are
checked in the Result Mapping pane.

You can change the result mapping to use any target XPath of your choice. For example, you can use the
Result Mapping tab to specify a Row Target such as Temp/RESULTINFO/Result as shown in the
graphic below.
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About Custom Result Mapping
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¥ exteNd Composer: TutorialEnd [IDBC: SampleJDBCInventorylookup]
File Edit View Component Action Animate Tools Window Help

D@8 Y00 @<

i =]
BO -8 x
Novell

['sQL Statement | Result Mapping |[ Result Text|

Result Row Placement

Epterthe X001 slament d

e [>]

& results under:

‘RESULT\NFOJROW

@ [ Create element names as column names

[ Create elements if column is null

[ Include datatype info in element attribute

[[] Generate Row numbers

O Custom Galumn/RowGroup |

[ Stored Pracedure mapping |

B Output |Dala ax
2 Temp Data 0 x
(<> RESULTINFO _g et £
<> e
<>3KU CHR1111
<> CATEGORY 3
<5 ONHAND 0
<> COST 9949
<> STATUS Out of Stack(on re-arder)
[ ROWY
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<

1>

‘STemp/RESU LTINFO/ROW

Result Mapping functionality includes the following default behaviors:

*

*

*

*

Target element names created in the document are the same as column names returned in the result

set

All columns returned in the result set are mapped to the target document

All columns are mapped to the same parent target element

All rows are placed into a single document

NOTE: Any column names that contain spaces will have the spaces replaced with the underscore

character since XML does not permit spaces in element names.

Use custom result mapping to:

*

*
*
*

*

Create target element names different than the column names returned

Map columns to different row targets

Group the result set data by one or more columns

Map only group information

Map group and detail information

Custom result mapping is accessed via the Custom ... button on the Result Mapping tab.

(®) Custom Column/RowdGroup

If you click this button, you will be presented with a dialog that has three tabs, labeled Map Target, Detail
Rows, and Declare Group/Repeat.
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Custom Mapping Settings x|
|' Map Target ][ Detail Rows |[ Declare Group /Repeat |
I W
Columns Context Target XPath Basef4 encode |
il MyTemp INVENTOR Y PRODUCTDetailTheCategory O
2 MyTemp IN'VENTOR'Y /PRODUCTDetail MySKU 2]
3 MyTemp IN'VENTOR'Y /PRODUCTDetailMyCnhand 2]
4 MyTemp IN'VENTOR'Y /PRODUCTDetailMyCost 2]
s O
Felp ©

The use of this dialog is discussed in detail below.

About Custom Result Mapping and Aliases

Novell Integration Manager’s default mapping behavior is to iterate through a list of one or more nodes
(i.e., elements specified by an XPath pattern) from a source document, and map them to a single target
document XPath location. If the target location doesn’t exist, Integration Manager creates it. If you know
the source list is greater than one, you must indicate to Integration Manager whether you wish to map to
the same physical target location for each member of the source list (i.e., overwrite the data in the
specified physical target location), or create a new physical target location for each member of the source
list (i.e., add new target locations as the repeated source is mapped). You indicate that you want to map
each member of the source list to the same physical target location by specifying the Context as an actual
DOM name. You indicate that you want to map each member of the source list to a new physical target
location by specifying the Context using an alias.

NOTE: This is also true for the Repeat for Element and the Repeat for Group actions.

You can think of the multiple rows of data returned by a SELECT statement as a repeating set of elements
in an XML document. In that case, you may choose to create a Declare Group action creating a list of
Groups and Detail elements within the Groups. Then you would create a Repeat for Group action to
process the Group list or detail of each Group. The Custom Map Target, Detail Rows, and Declare
Group/Repeat tabs provide a similar alias ability for repeating rows in SQL result sets as the Declare
Group and Repeat for Group actions do for repeating elements in a document.

Using the MapTarget Tab
The Map Target tab is used to:

+ Create your own target element names for each result set column
+ Specify a target Context for each result set column
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The Map Target tab controls the mapping of each returned row’s individual columns. For each column,
you specify a Context — Target XPath combination. The Context — Target XPath combination is specified
for each column in the order they are listed in the projection list for the SELECT statement in your
Execute SQL action. You cannot use Custom Result Mapping without filling in the Map Target tab.

The Map Target table will initially appear without any rows. Use the + icon to add additional rows. Use
the - icon to delete rows. Use the up and down arrows to arrange the rows of the Map Target table.

Column: This number refers to the columns in the order they are listed in your SELECT statement.

Context: This specifies the target document for the column. The Target XPath will be appended to the
Context to produce the full XPath location for the column in the target document. The Context can be a:

e Document — You may use this choice if your result set contains only one row, otherwise each
additional row will overwrite the previous row’s data.

o Detail Alias — A Detail Alias is defined on the Detail Rows tab and consists of a Document name
and partial Target XPath. Or the Detail Alias may consist of a Group Alias (defined on the Declare
Group/Repeat tab) and partial Target XPath location. Using a Detail Alias tells Integration Manager
to create a new physical target location for each member of the source list (i.e., each row in a result
set).

+  Group Alias — A Group Alias is defined on the Declare Group/Repeat tab and consists of a
Document name and partial XPath location. Using a Group Alias tells Integration Manager to
create a new physical target location once for each Group in the source list (i.e., where each group
represents multiple rows in a result set).

+  Repeat Alias — If the Execute SQL action is contained with a Repeat action in your Action Model
you may choose its Target alias. In this case, the Context will resolve to a Document and partial
XPath to which the Target XPath (see below) will be appended.

When grouping and mapping detail column data, the Declare Group/Repeat, Detail Rows, and Map
Target tab work together to define the complete XPath location for the column. (See illustration.) For
instance, a column on the Map Target tab will be represented by a Context and XPath. The Context may
be a Detail Alias defined on the Detail Rows tab. The Detail Alias in turn will represent another Context
and XPath. Its Context may be a Group Alias defined on the Declare Group/Repeat tab. Finally the Group
Alias itself will represent another Context and XPath.

By defining the Group and Detail aliases separately, you are able to map rows with duplicate column data
(the basis for your groups) just once into group header elements by using the Group alias as a context, and
map columns with unique data (the detail of your groups) multiple times within the group header
elements by using a Detail Alias whose Context is a Group Alias.

Target XPath: This is an XPath fragment that specifies the custom name to be given to the column and
optionally pre-pended by any additional parent elements. The Target XPath will be pre-pended by the
Context to produce the final location for the column in the target document.

Base64 encode: The checkbox in this column allows you to convert binary data to an XML-safe
representation for use in a DOM element.

NOTE: Integration Manager’s default behavior is to automatically Base64-encode binary data returned
from a database during a SELECT or other "read” operation. This is necessary to ensure that the target
XML node contains no “illegal characters.” See “Handling of Binary Data” on page 26.
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a Part context and target XFPath) can be substituted back
inta earlier tab context siots.

A processing summary for the Map Target tab is shown in the table below.

SQL Results Context = Document Context = Alias

One Row One row target is found or One row target is found or

Returned created for the first (and only) created for the first (and
result row. only) result row.

Multiple One row target is found or One row target is created for

Rows created for the first result row.  every result row.

Returned Subsequent rows find and

map to the same physical
target location. (Without an
alias, each row’s data is
overwritten by the next row
until only the last row’s data is
left.)
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Let’s assume your Execute SQL action issued the following statement:
SELECT CATEGORY, SKU, ONHAND, COST FROM InventorySystem

Which returned the following row data:

Category SKU Onhand Cost
3 CHR1111 0 999
2 DAD7777 89 245
4 GAR1234 17 100
1 LOR8437 0 275
1 LOR8438 21 375
4 MOM4666 233 300
4 RAC4567 156 230
4 ZAC9080 4 555

You could fill out the Map Target tab as shown below:

Custom Mapping Settings . x|
|' Map Target ][ Detail Rows |[ Declare Group /Repeat |
o wm Y

Columns Context Target XPath Basef4 encode |

1 Iy Temp INYVENTORY PRODUCTDetailTheCategory O

2 MyTemp INVENTOR'Y /PRODUCTDetaillySKU i

3 MyTemp INVENTOR'Y /PRODUCTDetaillyOnhand i

4 MyTemp INVENTOR'Y/PRODUCTDetaillyCost i

5 ]

Column one according to the SELECT statement will be CATEGORY. The Context is a document named
“MyTemp” and the target XPath location within the Context will be
“INVENTORY/PRODUCTDetail/TheCATEGORY”. Notice that CATEGORY is being renamed to
TheCATEGORY and being pre-pended with parent elements of INVENTORY/PRODUCTDetail. This
same logic applies to the remaining columns.

However, since we have yet to define or use any aliases, each row’s column data will be written to the
same four physical target locations specified on the tab. If only one row is returned, then its data will be
mapped to the target document with no problems. If multiple rows are returned as in our example, then
each successive row’s data will overwrite the previous row’s data until only the last row’s data exists.
(Only in rare cases will this situation be desirable.)
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- WySKU CHR1111
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Normally, you use the Map Target tab by itself if only one row is returned and all you wish to do is change
the names of the target elements to something different than the column names. (Or if you want to assign
different parent elements to individual columns.)

To avoid overwriting data with multiple result-set rows, you need to use a Detail Alias from the Detail
Rows tab telling Integration Manager to create a new physical target location for each row mapped.

Using The Detail Rows Tab

The Detail Rows tab allows you to create a mapping alias tied to either a document Context or a
Group/Repeat alias Context. Use of the Detail Rows tab is optional.

Detail Alias: This is a name you specify that will be referenced as a Context on the Map Target tab for
mapping columns in a result set row.

Context: This is a document name or Group/Repeat alias you specify. The Target XPath will be
appended to this Context to produce part of the final location for the column in the target document (the
remaining part comes from the Target XPath on the Map Target tab). The Context can be a:

+  Document — Using a Document name tells Integration Manager to create a new physical target
location once for each row in the result set.

o Group Alias — A Group Alias is defined on the Declare Group/Repeat tab and consists of a
Document name and partial Target XPath location. Using a Group Alias tells Integration Manager
to create a new physical target location once for each detail row belonging to each Group (i.e., each
group represents multiple rows in a result set).

Target XPath: This is an XPath fragment that you specify. It will be pre-pended by the Context on this
tab and appended with the Target XPath on the Map Target tab to complete the final location for the
column in the target document.

Looking at a Detail Rows Example

Assuming your Execute SQL action issued the following statement:
SELECT CATEGORY, SKU, ONHAND, COST FROM InventorySystem

You could fill out the Detail Rows tab as shown below:
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Custom Mapping Settings x|

Map Target | Detail Rows || Declare Group/Repeat

Detail Alias:

Pty TermpDetai

Representing:

MyTemp [~

‘INVENTORWPRODUCTDetaiﬂ e

[ 0K ][ Cancel ]

Since the Context MyTemp and Target XPath fragment INVENTORY/PRODUCTDetail are now
specified on the Detail Rows tab (creating a new physical target location for each row), references to
them must be replaced on the Map Target tab with the Detail Alias “MyTempDetail.” Continuing the
example used in the previous section, you would update the Map Target tab as follows:

Custom Mapping Settings x|
Map Target rDetaiI Rows][ Declare Gl'oup!Repeat]
o = W
Columns Context Target XPath Baseb4 encode |
1 My TempDetail TheCATEGORY ]
2 My TempDetai Iy SKU ]
3 My TempDetail MMy ONHAND ]
4 My TempDetai MyCOST ]
]
Help @ [ ok ][ cancel ]

By using a Detail Alias specified on the Detail Rows tab, you will ensure that if multiple rows are
returned in the result set, each row will create a new physical target location under
INVENTORY/PRODUCTDetail.

When not used in conjunction with the Declare Group/Repeat tab, you can think of the Detail Rows tab
as creating a “Repeat for Row” alias. If the Context for a Column on the Map Target tab is a Detail Alias
(instead of a document), then exteNd creates a new Target XPath each time a row mapping occurs. In this
way, multiple rows in the result set create multiple Row Targets in the document without overwriting the
previous row's data. This is the same functionality provided by the Result Mapping tab’s Custom...
option, except that you get to rename the columns.
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The result set data may not be arranged exactly the way we want, however. For example, the sub-trees
under PRODUCTDetail (see illustration above) are listed without regard to product category
information. If you look under PRODUCTDetail/TheCATEGORY, you can see that two rows belong
to category 1, and one row each belong to categories 2 and 3. (This example is in the Action Examples
project under the Sample directory in your Integration Manager installation. You might want to step
through the JDBC Component from which the above screen shot was taken, which is called “Custom
Result Mapping in JDBC.”)

Perhaps you’d rather see row data grouped according to category. To do this, you need to use a Group
Alias from the Declare Group/Repeat tab.

Using the Declare Group/Repeat Tab
The Declare Group/Repeat tab is used to:

+ Create groups of result set records based on one or more result set columns

¢ Create a Group Alias to use as a Context for Detail Rows

+ Create a Group Alias to use as a Context for Map Targets (creating Group Headers)

By declaring a Group Alias you create a list comprised of the unique values found in a column across

multiple rows. Any Map Target column that uses the Group Alias will map its column data only once for
each unique Group essentially creating group header information.

In addition, each unique group value points to a list of the rows that belong to it. Any Detail Alias on the
Detail Rows tab that uses the Group Alias will map its rows together for that group.

Group Alias: This is a name you specify that is referenced as a Context on the Map Target and/or Detail
Rows tabs.

Columns: Specify one or more columns separated by a comma to create your groups. Using two columns
means that only unique combinations of the concatenated values of the two columns will create a group.

NOTE: The columns you specify must form the basis of an ORDER BY clause in the SELECT statement
for the Execute SQL action. If you omit the ORDER BY clause, your results will be unpredictable.

Using Custom Result Mapping 55



Context: This is a document name in the component or Repeat for Group or Repeat for Element alias in
the Action Model that contains the Execute SQL action. The Target XPath is appended to this Context to
produce part of the final location for the column in the target document. (The remaining part comes from
the Target XPath on the Map Target tab and optionally from the Target XPath on the Detail Rows tab.)
The Context can be a:

+ Document — Using a Document name tells Integration Manager to write to the same physical
document for each Group.

+ Repeat for Group Alias — If your Execute SQL action is inside a Repeat for Group action in your
Action Model, then you may use its target alias as the Context for each Group. This tells Integration
Manager to create new Groups once for each Group processed in the enclosing Repeat for Group
action.

+ Repeat for Element Alias - If your Execute SQL action is inside a Repeat for Element action in
your Action Model, then you may use its target alias as the Context for each Group. This tells
Integration Manager to create new Groups once for each repeating element processed in the
enclosing Repeat for Element action.

Target XPath: This is an XPath fragment that you specify. It is pre-pended by the Context on this tab and
appended with the Target XPath on the Map Target tab (and optionally with the Target XPath on the
Detail Rows tab) to complete the final location for the column in the target document.

Looking at a Declare Group/Repeat Example
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Assuming your Execute SQL action issued the following statement:
SELECT CATEGORY, SKU, ONHAND, COST FROM InventorySystem order by CATEGORY

You could fill out the Detail Rows tab as shown below:

Custom Mapping Settings |

Map Tarzet || Detail Rows | Declare Group/Repeat |

dh =W

| Group Alias | Columns | Context | Target XPath
GCATEGORY [CATEGORY [Output [NVENTORY/ACATEGORYIGROUP |

[ ok ][ Cancel ]

Similar to the example for Detail Rows, since the Context MyTemp (and Target XPath fragment
INVENTORY/PRODUCT) is now specified on the Declare Group/Repeat tab, references to it must be
replaced on the Detail Rows tab with the Group Alias “gCATEGORY.” In addition, you are no longer
listing just PRODUCTDetail under INVENTORY but rather groups of PRODUCTDetail so a new
element is introduced into the Group’s Target XPath called “ACATEGORY Group.” Thus for each Group
mapped, a new ACATEGORY Group element is created.

Continuing the example used in the previous two sections, you would update the Detail Rows tab as
follows:
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Custom Mapping Settings |

Map Target | Detail Rows || Declare Group/Repeat

Detail Alias:

Py OutputDetail

Representing:

GCATEGORY [~]

‘PRODUCTDetaiﬂ 4

ok ][ cancet |

Notice that the Context of “MyTemp” has been replaced by the Group Alias gCATEGORY which
represents MyTemp/INVENTORY/ACATEGORY Group. This means that Detail Rows belonging to the
Group are the only ones mapped, instead of all the Detail Rows.

Continuing the example used in the previous two sections, you would update the Map Target tab as
follows:

Custom Mapping Settings x|

Map Target | Detail Rows | Declare Group/Repeat |
=W

Columns Context Target XPath | Base64 encode |
1 gCATEGOR™Y TheCATEGORY J
2 MyOutputDetail  [MySHU (]
3 MyOutputDetail  [MyOMHAND (]
4 MyOutputDetail  MyCOST (]
5 I ] ]

[0k _J[ Cancel |

We have replaced the Context for the CATEGORY column with the Group Alias. This means that
CATEGORY is only mapped once for each Group instead of once for each detail row.
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B MyTemp Data
== > INVENTORY
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i > TheCATEGORY |3
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...... < 2 MyQNHAND|D
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£ > ACATEGORYGroup
i > TheCATEGORY 2
£ > PRODUCTDeta
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When you declare a Group Alias, the result set rows are scanned and organized into groups establishing
how many processing loops will occur during mapping. If eight rows are in the result set with only four
different values (e.g., 3,2, 4, 1, 1, 4, 4, 4) then there will be four group mapping loops (e.g., 1,2, 3,4) and
eight detail loops tied to their appropriate group mapping loops (e.g., group one has its two detail rows,
group two has its one detail row, group three has its one detail row, and group four has its four detail
TOWS).

Using the prior graphics, you can trace how the final context for the Map Target columns is constructed
for Column one and Column two. Column one is the CATEGORY from the result set. Its name in the
DOM will be TheCATEGORY. Its ancestor elements are determined by the context “gCATEGORY”
defined as MyTemp/INVENTORY/ACATEGORY Group on the Declare Group/Repeat tab. So the final
XPath for CATEGORY is:

Output/INVENTORY/ACATEGORYGroup/TheCATEGORY

Since the context for TheCATEGORY is a Group alias, it will be mapped once for each group or four
times as determined earlier.

Column two is the SKU data from the result set. Its name in the DOM will be MySKU. Its ancestor
elements are determined by the context “MyTempDetail” defined to be gCATEGORY (defined above)
plus PRODUCTDetail. So the final context for the column will be
MyTemp/INVENTORY/ACATEGORY Group/PRODUCTDetail/MySKU. Since the context for
MySKU is a Detail Alias, it is mapped once for each Detail Row. However, each Detail Row has a
Context of a Group Alias limiting mapping to only those detail rows that belong to the Group.
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Stored Procedures

Novell Integration Manager supports the mapping of data returned by stored procedures. The following
sections describes the stored procedure mapping features.

About Stored Procedure Mapping

Novell Integration Manager allows for mapping the data returned by stored procedures to DOM/Node
combinations. To do so, select the Stored Procedure mapping checkbox on the Result Mapping tab in
the Query/Results Mapping Pane.

SGL Statement Result Mapping | ResuItTE}{tl

Result Row Placement
Enter the xhL element to place results under:

[Temp |

INVEMTORYSTATLIS

i* |v Create element names az column nameas
W Create elements if column iz null
Include datatype info in element attribute

Generate Row numbers

% Custom Column/RowGroup Custam... |
| p Stored Procedure mapping Setup... | |

This will enable the Setup... button. Press the Setup... button to display the Setup dialog for Stored
Procedure Mapping.

Setup E
Stored Procedure Mapping:

op o [ Retums Result Set

Id | Qual | Data Type | Scalel Mapl Context Target XPath

Cancel

Help
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Binding Rules

It is important to understand Integration Manager binds to all Expressions and placeholders represented
by Question Marks placeholders (e.g. either “:<expression>’ or ? ) but not Constants (e.g. ‘abc’).

Using the Stored Procedure Mapping Setup Dialog

60

The Stored Procedure Mapping Setup dialog is used to map the data returned by a stored procedure. The
Setup dialog allows you to specify Context - Target XPath combinations for the returned data.

Use the + and - controls to add and delete Context - Target XPath combinations.

Oracle RDBMSs return result sets as parameters. Non-Oracle RDBMSs return result sets but, not as
parameters. Select the Returns Result Set check box when result sets are returned by non-Oracle
RDBMS:s. Selecting the Returns Result Set check box for non-Oracle RDBMSs enable Integration
Manager to find the returned result set.

NOTE: All Expressions and placeholders (e.g. ?) must be specified in the Stored Procedure Mapping
Setup dialog in order to correctly map the returned data.

For each returned Input/Output parameter (which may be expressions) and each Output parameter
(which may be either an expression or a ?) (see the Rules for Stored Procedures section in Chapter 4),
complete the following:

Id: Based on the SQL parameters, Id is the number sequence of the return values you’re expecting. Using
Id, you will need to explicitly specify the sequence positions of each of the parameters containing either
expressions (e.g. ‘:<ExpressionName>") or placeholders (e.g. ?). For example, the following procedure
call has three parameters: a constant, ‘Process’, a placeholder, ? and an expression, ‘:Smith’. The value
‘Process’ does not need an Id in the Stored Procedure Mapping pane since Integration Manager does
not bind to values. The Id entries for the placeholder - ? and the variable ‘:Smith’ are, respectively, 2 and
3. Integration Manager binds to variables and placeholders, therefore, they must be specified in the
Stored Procedure Mapping pane in order to properly map the data returned by a stored procedure.

Example:
{ call DemoPackage.sp withParams ('Process', ?, ':Smith') }

Qual: Qual qualifies the parameter as an Input parameter, an Output parameter or as an Input/Output
parameter.

Data Type: Data Type is a drop down list which provides the following options: VARCHAR,
DECIMAL, DATE, BINARY or Oracle Result Set. When Oracle Result Set is selected as an Input
parameter (Qual=In), Context and Target XPath do not apply (N/A) and are, therefore, disabled.

Scale: The value of Scale specifies the decimal place precision.
Map: The Map checkbox is selected to map the parameter.

Context: this specifies the target document for the column. The Target XPath will be appended to the
Context to produce the full XPath location for the column in the target document. The Context can be a:

e Document — You may use this choice if your result set contains only one row, otherwise each
additional row will overwrite the previous row’s data.

+  Detail Alias — A Detail Alias is defined on the Detail Rows tab and consists of a Document name
and partial Target XPath. Or the Detail Alias may consist of a Group Alias (defined on the Declare
Group/Repeat tab) and partial Target XPath location. Using a Detail Alias tells Integration Manager
to create a new physical target location for each member of the source list (i.e., each row in a result
set).
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o Group Alias — A Group Alias is defined on the Declare Group/Repeat tab and consists of a
Document name and partial XPath location. Using a Group Alias tells Integration Manager to
create a new physical target location once for each Group in the source list (i.e., where each group
represents multiple rows in a result set).

+ Repeat Alias — If the Execute SQL action is contained with a Repeat action in your Action Model
you may choose its Target alias. In this case, the Context will resolve to a Document and partial
XPath to which the Target XPath (see below) will be appended.

+  --via standard -- will use the Result Mapping tab’s Result Row Placement specification.

* --via custom -- will use the settings on the Custom Mapping Settings dialog.

When grouping and mapping detail column data, the Declare Group/Repeat, Detail Rows, and Map
Target tab work together to define the complete XPath location for the column. (See illustration.) For
instance, a column on the Map Target tab will be represented by a Context and XPath. The Context may
be a Detail Alias defined on the Detail Rows tab. The Detail Alias in turn will represent another Context
and XPath. Its Context may be a Group Alias defined on the Declare Group/Repeat tab. Finally the Group
Alias itself will represent another Context and XPath.

By defining the Group and Detail aliases separately, you are able to map rows with duplicate column data
(the basis for your groups) just once into group header elements by using the Group alias as a context, and
map columns with unique data (the detail of your groups) multiple times within the group header
elements by using a Detail Alias whose Context is a Group Alias.

Target XPath: This is an XPath fragment which will be appended to Context to specify the full XPath
location int the target document.

Returned Result Set

A result set is mapped to a document with elements created from the result set’s column names.

+ Target element names created in the document are the same as column names returned in the result
set

+ All columns returned in the result set are mapped to the target document

+  All columns are mapped to the same parent target element

+ All rows are placed into a single document

NOTE: Any column names that contain spaces will have the spaces replaced with an underscore
character since XML does not permit spaces in element names.
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JDBC Glossary

Connection Pool

A set of database connections managed by the application server for the various applications it manages.

Custom Result Mapping

The Custom Result Mapping dialog provides a similar alias ability for repeating rows in SQL result sets as the Declare Group
and Repeat for Group actions do for repeating elements in a document.

Declare Group/Repeat Tab

This tab of the Custom Results Mapping dialog is used to create groups of result set records on one or more result set columns,
create a Group Alias to use as a Context for Detail Rows, and create a Group Alias to use as a Context for Map Targets (creating
Group Headers).

Detail Rows Tab

This tab of the Custom Results Mapping dialog allows you to create a mapping alias tied to either a document Context or a
Group/Repeat alias Context. Use of the Detail Rows tab is optional.

DOM

A Document Object Model (DOM) is an XML document constructed as an object in a software program's memory. It provides
standard methods for manipulating the object. In Integration Manager, DOM is often synonymous with XML Document.
DOMs are represented as hierarchical trees with a single root node.

DOM Context

The name of a DOM (Input, Output, Temp, etc.), or the name of a Repeat alias previously defined in the component. (The alias
itself represents a DOM context, representing the nodepath hierarchy upstream of a given element.)

Execute SQL Action

Same as SQL Statement Action.

JDBC

A Sun trademark for the Java API for accessing relational database data. It is commonly assumed to mean Java Database
Connectivity.

Map Target Tab

This tab of the Custom Results Mapping dialog is used to create target element names for each result set column and specify a
target Context for each result set column.

Native Environment Pane

A pane in the JDBC Component Editor that simulates an actual SQL environment when you issue a query.
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Query/Result Mapping Pane

(Same as the Native Environment Pane.) A pane in the JDBC Component Editor that includes three tabs: the SQL Statement
tab, the Result Mapping tab, and the Results Text tab.

Result Mapping Tab

A tab in the Query/Result Mapping Pane that allows you to map the result of your database query to an XML document.

Result Text Tab

A tab in the Query/Result Mapping Pane that displays the actual data that was returned following the execution of the database
query.

Row Target

The receiving element in a mapping operation is called the row target. It represents a specific position in the DOM tree of an
XML file.

SQL Statement Action

Most commonly used to query an existing database and then map the result to an XML document.

SQL Statement Tab
A tab in the Query/Result Mapping Pane that allows you to write or build SQL commands.

SQLCODE

A global ECMAScript variable created by the execution of SQL statements. Contains a status code generated by the database
engine.

SQLSTATE

A global ECMAScript variable created by the execution of SQL statements. Contains information generated by the database
engine.

UPDATECOUNT

A global ECMAScript variable created by the execution of SQL statements. Contains a count of the number of rows changed
by the database engine.
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Reserved Words

The following terms are reserved words in Integration Manager for the JDBC Connect and should be
avoided in any user created labels or objects.

*

*

*

SQLCODE
SQLSTATE
UPDATECOUNT
LASTSQL

Reserved Words
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